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KNOWHOW 
FOUR THINGS 
THAT WE LOVE 
ABOUT AFFINITY
Here are the features which we 
think make Affinity the best new 
editing software on the market.
 

LIVE FILTERS
If you’re the creative type 
who always adds Radial 

Blurs or likes to Liquify, you’ll love 
the ability to see your effects in 
real-time. This aspect really takes 
the guesswork out of complicated 
edits, meaning everybody has the 
power to create stunning results.

TONE MAPPING  
HDR is an area which 
many still consider a 

complicated process. However, 
thanks to the dedicated Persona, 
merging multiple shots couldn’t 
be more simple. It offers a series 
of one-click presets, as well as 
sliders to create the perfect shot.

FULL CUSTOMISATION
Affinity is set up in such 
a way that nearly all 

aspects can be customised to 
your liking. Through a simple 
process, you can add tools and 
tabs, ensuring that your favourites 
are always close to hand, and best 
suited to your needs.

AFFINITY FOR IPAD
Not content with creating 
an amazing desktop 

experience, Affinity is also 
responsible for the best image 
editing app on any mobile device. 
It’s so good, you can follow along 
with these tutorials without 
leaving the sofa.

GETTING STARTED  AFFINITY PHOTO 

Kirk Schwarz takes an in-depth look at Affinity 
Photo, an award-winning photo editing suite that 
offers powerful features at an unbeatable price.

I N THE WORLD OF 
image editing, plenty 

of software packages claim to 
offer the ultimate experience. 
But none of these have excited 
us as much as Serif’s Affinity 
Photo editing suite.

This fully-featured editing 
software manages to create 
a perfect balance between 
familiarity and innovation 
thanks to its use of industry 
standard tools, as well as an 
ethos of creative freedom. 
Few packages share such 
an incredible feature list as 

Affinity, truly meaning the 
only limit to your creativity 
is your imagination. 

As well as allowing you 
access to such essentials as 
Layers and Masks, you also 
have excellent Live Filters, 
which allow you to see the 
effects as you apply them – 
a must for the perfectionist 
in us all. It also offers a huge 
degree of customisation, 
non-destructive adjustments 
and the amazing ability to 
work with PSD files, meaning 
you won’t lose your back 

catalogue of Adobe work 
when you switch over.

With such impressive 
specs, it’s little wonder that 
Affinity has claimed both our 
own five-star Highly Rated 
and Best in Test awards on 
every appearance, as well as 
an Apple award for App of 
the Year 2017. 

Therefore, throughout this 
special supplement, we’re 
going to explore the key 
aspects of this amazing 
software, taking an in-depth 
look at exactly what Affinity 
Photo can really do, including 
a peek at the amazing iPad 
version, which is hands down 
the best fully featured mobile 
image editing software 
available, offering a near-

identical experience to the 
desktop version. 

What you can expect 
We’ll be running through  
all aspects of photo editing, 
starting out in this issue 
with a look at the Develop 
Persona, where we’ll show 
you how to get the best out  
of your RAW files. 

We’ll also be looking at 
Affinity’s ability to create 
stunning landscapes, 
thanks to the Tone Mapping 
Persona, as well as how to 
make the most of the brilliant 
portrait features, which 
includes one-click frequency 
separation, taking all of the 
hard work and effort out of 
this advanced technique.

AFFINITY HAS CLAIMED OUR 
VERY OWN COVETED FIVE-
STAR BEST IN TEST AWARD

ONE-TIME 
PAYMENT

n Affinity Photo is yours for 
the one-off cost of £48.99, or 
only £19.99 for the iPad app

n Visit affinity.serif.com/
photo

LANDSCAPES MAKE YOUR 
WORK SHINE IN ONE CLICK 
Affinity has a number of 
powerful tools for landscape 
photographers, including a 
dedicated Tone Map Persona. 
Opening your images in this 
Persona allows you to merge 
a series of photos together to 
create an HDR image, which 
you can fine-tune with a series 
of dedicated sliders. 

PORTRAITS EASILY CREATE 
HIGH-END RESULTS
When it comes to editing 
portraits, the more advanced 
skin retouching techniques 
used to be a difficult trick to 
master. Luckily, Affinity makes 
everything so simple, even 
including a one-click Frequency 
Separation mode.

BEFORE

BEFORE

AFTER

AFTER

Affinity Photo 
The new king of editing

PART 1
GETTING 

STARTED WITH 
AFFINITY  
PHOTO
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A FFINITY PHOTO 
has been designed 

from the ground up to offer 
an unbeatably smooth and 
intuitive experience. It’s 
powerful enough to impress 
any professional looking for 
a fully-functioning editing 
suite, while also allowing 
first-time users to create 
fantastic results. It achieves 
this by dividing tasks into 
Personas. These tabs house 
various editing setups, and do 
an excellent job of keeping 
your workflow intuitive.

With just a single click, 
you have access to a wealth of 
abilities, including powerful 
Tone Mapping to create HDR 
images, the most intuitive 
Liquify tool available and an 
excellent RAW conversion 
experience. When you start 

using these alongside the raft 
of industry standard tools 
and adjustments on offer, 
you’ll see why Affinity Photo 
has been winning awards and 
earning widespread acclaim 
since its initial release.

Personas explained
Here, we’ll be taking a quick 
look at what each Persona is 
capable of, offering you a brief 
overview and pointing out 
some of our favourite key 
features, many of which may 
be surprisingly familiar to 
you. Over the course of this 
complete guide, we’ll also be 
going in-depth to show you 
some simple ways to achieve 
excellent results, covering 
genres from landscapes to 
portraits, and everything 
in-between.

PHOTO PERSONA 
HOME TO TOOLS, LAYERS 
AND ADJUSTMENTS
Packed with industry standard 
tools, adjustments and creative 
filters, the Photo Persona is 
where the majority of your 
editing will take place. Whether 
it’s working on your colours, 
adding selective Dodging 
and Burning or even creating 
sprawling complex photo 
composites, this is where 
the magic happens.

SO MANY OPTIONS
Affinity houses a wide range of 
features to aid in your editing. 
Everything from an infinite 
History slider to a powerful 
integrated stock photography 
panel is waiting for you to take 
full advantage of. 

ADJUSTMENTS GALORE
With so many Adjustment 
Layers available, non-
destructive editing gives you 
the freedom to edit without 
fear of ruining your shots.UNOBTRUSIVE EDITING

The large canvas area makes it 
simple to keep your eyes on your 
work, with Affinity blending 
seamlessly into the background.

CUSTOMISABLE TOOLBAR
Affinity allows you to add your 
most used tools, making 
complex editing even easier.

PERSONA PANEL
Changing between the different 
Personas is really as simple as 
clicking their dedicated icons at 
the top of the screen.

MULTIPLE LAYERS
Affinity supports Layers, which 
means you can create complex 
composite images, really letting 
your imagination run wild.

LIQUIFY PERSONA 
RESHAPE YOUR SHOTS 
WITH THIS AMAZING TOOL
Liquify is an impressive 
image reshaping feature, 
including tools such as Push 
Forward, Pinch and Punch. 
However, Affinity takes it one 
step further by showing the effects 
in real-time, including any underlying 
Layers, as well as adding a customisable grid, allowing 
for precise control, and a Reconstruct Mesh, which can 
automatically lessen the effect by any degree – amazing.

DEVELOP PERSONA 
A POWERFUL RAW 
CONVERSION MODULE
RAW conversion is an 
essential, and Affinity’s 
Develop Persona is 
outstanding, allowing you full 
control over fundamentals such 
as Exposure, Contrast and White 
Balance. You also have an advanced 
lens distortion correction tab, as well as the excellent Before 
and After tools, which allow you to make sure you’re happy with 
changes before you jump to the other Personas to finish the job.

TONE MAPPING PERSONA 
CREATE BREATH-TAKING 
HDRS IN MERE SECONDS
Tone Mapping maximises a 
shot’s dynamic range, which it 
achieves by merging data from 
multiple bracketed images. 
However, Affinity’s Tone Mapping 
Persona works just as well with a 
single image, giving you instant results. 
You have access to a large library of one-click effects, including 
the excellent James Ritson custom creations, and a wide array 
of sliders allow you to craft the effect that best suits your vision.

EXPORT PERSONA 
HAVE PRECISE CONTROL 
WHEN SAVING YOUR WORK
While you can easily save your 
work without utilising the 
might of the Export Persona, 
those who have the same 
exacting standards as us will be 
delighted at the power this module 
offers. Allowing full control over saving 
your images makes sure the world sees them as you intended. 
Affinity Photo even lets you save as PSD files, meaning working 
with cross-platform clients becomes incredibly simple.

A quick look 
into the power 
of Personas

NEVER BLAME 
YOUR TOOLS
Everything you 
need to edit your 
photos is right  
at your fingertips 
in this handy 
toolbar. You can 
even customise  
it to make sure 
you have quick 
access to your 
favourite tools.
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CREATIVE TRAVEL PRO
JECTS

KNOWHOW 
WHY AFFINITY IS 
PERFECT FOR 
LANDSCAPES
Affinity is a fully-featured editing 
package, which offers you all 
the top-end professional tools, 
allowing you to create truly 
stunning results. 
 

DEVELOP PERSONA
No landscape editing 
would be complete 

without the ability to tweak your 
RAW files. The Develop Persona 
gives you the flexibility to recover 
highlights, create selective edits 
and perfect your colours. 

ALL THE TOOLS
Affinity’s strength comes 
in its variety. Instead of 

hand-holding, it allows you true 
creative freedom, meaning you 
can create the edit you have in 
your mind, without having to 
worry about constraints. 

EDIT AS YOU SHOOT
The brilliant iPad app 
offers everything the 

desktop version does, including 
RAW editing. This means you can 
transfer your shots to your iPad as 
you shoot, and have them edited 
before you even get in the car. 

LANDSCAPES  AFFINITY PHOTO 

Kirk Schwarz walks you through getting the most 
out of your landscape photos using Affinity’s RAW 
editor and the powerful Tone Mapping Persona.

W ITH SO MANY 
stunning landscapes 

around us, ripe for capture, 
they’re a staple of our 
photography portfolios. 
Whether it’s sunrise, sunset 
or just an interesting location 
we’ve stumbled across, we’re 
never without our cameras. 

Of course, even the best 
shot in the world can benefit 
from a touch of editing, and 
that’s where the excellent 
Affinity Photo comes into 
play. On the previous pages, 
we journeyed through the 

five different Personas, taking 
a brief look at what this 
very powerful photo 
editing software could offer. 
Now we’re going much more 
in-depth with a longer look at 
the Tone Mapping Persona. 

Using a RAW landscape 
image, which we’ll show 
you how to convert in the 
Develop Persona first, we’re 
going to choose a custom 
Tone Mapping preset from 
the many on offer and walk 
you through the huge range 
of customisation options. 

The joy of having so much 
control is that it really allows 
you to make each shot your 
own and actually gives you 
the level of freedom to be as 
subtle or as crazy as you want 
in your final edit. 

When you’ve finished in 
the Tone Mapping Persona 
and applied an HDR look to 
your image, you’ll then be 
placed back into the Photo 
Persona, which means you 
can carry on editing, using 
tools such as the Clone Stamp 
Tool to tidy up any little 
imperfections, or even throw 
in a couple of Adjustments, 
meaning you can change the 
Colour Balance, add some 
Split Toning or even convert 
your shot to black & white if 

that’s the look you’re after. 
The choice is entirely yours. 

Which photo?
We’re using a shot from Blyde 
Canyon in South Africa, but 
you are free to use any photo 
you’d like, though the 
technique will work best 
if you make sure you have 
a shot with plenty of contrast, 
and with details captured in 
both the shadows and the 
highlights. This will ensure 
the Tone Mapping has 
enough data to work with as 
it processes the initial image. 
Of course, even though this is 
a landscape masterclass, 
you’re free to try it with any 
of your shots, even wildlife  
or portraits.

THE JOY OF HAVING SO 
MUCH CONTROL IS THAT IT 
MAKES A SHOT YOUR OWN

LANDSCAPES REVEAL THE HIDDEN DETAIL IN YOUR SHOTS
Affinity Photo has a tool or adjustment for every occasion. These 
include Dodge, Burn and Curves – ideal to add the perfect contrast. 

EDIT YOUR SHOTS ON THE MOVE THE AMAZING AFFINITY IPAD APP
When you’re out shooting landscapes and you want to get started with the editing process 
straight away, the Affinity Photo app is a boon. It offers an identical level of functionality as 
the desktop app, so you can even follow along with this tutorial on the go.

BEFORE

AFTER
Affinity Photo 
Landscape masterclass

PART 2
ENHANCING  

AMAZING   
LANDSCAPES

TONE MAPPING 
PERSONA
Giving you the ability to 

create instantaneous HDR results 
from multiple or single images, 
the Tone Mapping Persona is as 
simple as it is powerful. You even 
have access to the brilliant James 
Ritson custom profiles.



DISCOVERAFFINITY...

2
Add some contrast to make it pop
Set the Contrast and Clarity sliders to bring out the 
details – to 12% and 10% respectively in our shot. If your 

colour isn’t jumping out, you can increase Vibrance to bring out 
rich tones – we’ve gone to 50% and the result is subtle.

4
Use a gradient to edit your sky
Click the Overlay Gradient Tool and select Linear. Now 
drag from mid-sky to your horizon. The red mask is the 

only area that editing will affect, so use the previous three steps 
to perfect your sky. Click Develop when you’re finished.

1
Get your exposure spot on
Open your Basic Tab and increase the Exposure and 
Brightness sliders to lighten or darken the image, but 

don’t blow your highlights. You can also increase your Blackpoint 
to 5% to deepen the blacks, which really makes the shot pop.

3
Recover your shadows and highlights
Click on Shadows & Highlights and slide Shadows right 
to increase the brightness in the darker areas – we’ve 

gone to 15%. Slide the Highlights slider left to recover details in 
the brighter parts, preventing the sky from being too bright.

Give yourself a head-start with 
Affinity’s Develop Persona
W E ALL KNOW 

that RAW files 
capture a phenomenal 
amount of data in comparison 
to JPEGs. However, to make 
the most of this data, you 
need the software to read it 
– which is where the Develop 
Persona really shines.

In this first step you’ll see 
how to make the most out of 
your RAW landscape image, 
recovering highlights and 
shadows, as well as adding 
some vibrancy, perfecting the 
colours and using gradient 
tools to add selective edits. 
This will allow you to make 
skies look moody without 
affecting your perfectly-
exposed foregrounds.

Once you’ve explored the 
tools on offer and created  
your very own magnum opus, 
you’ll be taking it into the 
Tone Mapping Persona to add 
the final touches and bring 
out all the hidden details. 

With Affinity Photo’s 
ethos of creative freedom, 
you are always able to jump 
back into the Develop 
Persona to touch up your 
work if you’ve missed 
something in the edit, as 
well as moving seamlessly 
between the Develop and 
Photo Persona, which gives 
you access to tools such as 
the Clone Stamp Tool, Colour 
Balance or the powerful 
Dodge and Burn.

LANDSCAPES  AFFINITY PHOTO 

AFTER

BEFORE

AFFINITY PHOTO ALLOWS 
YOU TO MOVE SEAMLESSLY 
BETWEEN THE PERSONAS

Above & top This RAW image doesn’t do the scene any justice. 
With just a few tweaks, you can completely change your shot.

OVERLAY GRADIENT TOOL
This allows you to mask off 
an area, meaning only your 

chosen area will be affected by any 
editing, perfect for bright skies.

OVERLAY ERASE TOOL                  
This handy erase tool allows 
you to remove any area of 

your mask by simply brushing, which 
is great for detailed fine-tuning.

OVERLAY PAINT TOOL
Similar to the Gradient Tool, 
but this actually allows you to 

create your mask with a brush tool for 
pin-point precision.

KNOWHOW THREE TOOLS FOR PRECISION EDITING

TIP 
RE-DEVELOP

This tutorial refers to RAW 
conversion, but Affinity lets 
you use the same tools on 
your JPEGs. Simply click 

the Develop Persona 
at any time.
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Fix the colours with a mask
Click the Overlay Paint Tool, and simply brush over  
the saturated areas to create a mask. Now reduce the 

Saturation and Vibrance sliders. If you’ve made a mistake, click 
the Overlay Erase Tool to erase the mask. Now click Apply.

1
Open the Tone Mapping Persona
Once you’ve finished the Develop process, you’ll be sent 
to the Photo Persona. This is great for getting in-depth, 

but Affinity has an easier path to amazing results – simply click 
the Tone Mapping Persona to carry on.

3
Adjust your tonal compression
For this scene, the instant effect is a little too powerful. 
Sliding the Tonal Compression slider left will reduce the 

overall effect, while dragging the Local Contrast slider left will 
decrease the clarity in the image, making it a touch more natural.

4
Edit the exposure to suit your scene
You’ll recognise the same tool layout as the Develop 
Persona, which keeps this step simple. Drag the 

Exposure, Blackpoint and Brightness sliders to fix your Exposure, 
and use the Shadows & Highlights to bring back any lost details.

Use Tone Mapping  
to create instant impact
C REATING HDR 

photos can be an 
in-depth and advanced 
technique, often requiring 
you to shoot a series of 
exposure bracketed images 
(meaning they’re shot at 
different exposures). Affinity 
Photo includes a dedicated 

Tone Mapping Persona to 
take on some of this work. 
While this Persona does 
allow you to import multiple 
images and create your final 
shot, it can also create the 
effect using a single 
exposure, which it will 
automatically turn into a 

stunning HDR image at the 
click of a button. The best 
thing about this technique is 
that you have a wide range of 
one-click presets designed to 
cover nearly every type of 
shot you can envisage. You 
can even see the results in 
real-time. You also have the 

usual exposure, contrast and 
colour tools, as well as Tonal 
Compression, Local Contrast 
and even an excellent 
Overlay Paint Tool to create 
a custom mask, allowing for 
a truly mind-blowing level of 
selective editing possibilities 
for your landscape images.

AFTER

BEFORE

Above & left We’ve turned our RAW 
image into a great starting point, making 
sure we have plenty of tones. In just five 
steps, you can really ramp up the visual 
impact of your shot.

TIP 
EXPERIMENT

With such a wide range of 
presets available, don’t be 

afraid to experiment.  
The menu even offers 
Crazy and Extreme 

options.

KNOWHOW THREE OF THE 
BEST ONE-CLICK EFFECTS
With so many on offer, we thought we’d give you a helping 
hand by showing you our three favourite presets, ranging 
from a calm and natural look, to something more extreme.

DRAMATIC
Found under the 
Default tab, this 

punchy preset gives you an 
instant colour boost without 
giving you too much clarity. 
It’s ideal for bright images 
with a wide range of 
colours, and is perfectly 
suited to bring out the best 
details in your favourite 
summery blue-sky shots.

MAXIMUM GRIT
Found under the 
Extreme tab, this 

preset is unashamedly HDR. 
Packing in a huge amount of 
Local Compression and an 
increase in sharpening, it is 
perfect for gritty black & 
white portraits, especially 
on those subjects who have 
one or two wrinkles or 
furrowed brows. 

2
Select your Preset
In the Tone Mapping 
Persona, on the left you’ll 

see the presets. Open the drop-down 
menu and click James Ritson Customs. 
For this tutorial, we’ve used the ‘Lift Shadows, 
Max Punch’ preset, though feel free to experiment.

LANDSCAPES  AFFINITY PHOTO 

ARCTIC CHAMBER
This James Ritson Custom is ideal for enhancing 
those tones. Bringing the colour temperature 

down and increasing the Local Contrast, it’s perfectly 
suited for bringiong the most out of your foreground, 
making it ideal for long-exposure winter waterfalls. 
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KNOWHOW 
WHY AFFINITY IS 
PERFECT FOR 
B&W EDITING
Affinity’s brilliant non-destructive 
adjustments allow a huge range of 
creative freedom. These come into 
their own when converting colour 
to stunning black & white. 

 

BLACK & WHITE
Starting with an obvious 
one, the powerful Black 

& White Adjustment allows you to 
fine-tune each individual colour 
with simple sliders. This lets you 
make micro changes that are 
otherwise near-impossible.

LEVELS AND CURVES 
Affinity offers both, 
allowing you to fine-tune 

shadows and highlights to the nth 
degree, which is perfect for those 
eye-catching black & white 
conversions with ultra-bright 
whites and smooth blacks.

GRADIENT MAP
Our personal favourite, 
adding a Black & White 

Gradient Mask allows you to 
place your tones exactly. This 
is perfect for taking control over 
the all-important transitions in 
your monochromatic images.

URBAN MONO  AFFINITY PHOTO 

Kirk Schwarz shows you how to get the most from 
your abstract architecture and gritty black & white 
street photos in this easy to follow tutorial.

C ITIES ARE GREAT 
for so many reasons. 

Not only do they often have 
the best shops and a vibrant 
night-life, but they also offer 
incredible architecture and 
loads of creative potential. 

Exploring busy shopping 
precincts and more secluded 
back alleys will reveal a whole 
host of intriguing characters, 
just begging to be framed up 
by your camera. 

If you prefer your subjects 
to be silent and static, the 
often eclectic mix of old stone 

buildings and purpose-built 
steel monoliths provide the 
perfect playground for 
adventurous architectural 
photography enthusiasts. 

Of course, taking the shot 
is only the first step on the 
way to greatness. A small 
amount of natural editing 
can help to really uncover the 
hidden potential in even your 
best work. Adding simple 
edits, such as contrast and 
clarity, will give your shots 
a gritty look, while managing 
to emphasise every little 

detail for your viewers to 
marvel at. Taking it one step 
further, adding a Soft Proof 
Adjustment will allow you to 
instantly create a beautiful 
washed-out look, adding an 
extra depth to your tones 
with a traditional film 
appearance. You can also 
explore the Tone Mapping 
Persona, using HDR to ramp 
up your street portraits.

Keep ultimate control
All of these techniques are 
non-destructive, so you can 
go back and fine-tune your 
individual Layers to ensure 
you have the perfect results. 
And don’t forget that Affinity 
will save these Layers, as well 
as your full History, meaning 

you can re-jig your edit as 
much and as often as you 
like. To really harness the 
power of black & white, it’s 
important that you have a 
shot that translates well. 
The best mono photographs 
are often those which have 
plenty of contrast, and a 
strong amount of dominant 
shadows and highlights. You 
can often find the right mix 
in shots taken in directional 
light, early morning or late 
afternoon, when the sun is 
at its lowest point. 

Finding this perfect mix 
increases the depth, so try 
and make this work to your 
advantage by having one side 
in constant light, and the 
other bathed in deep shadows.

NATURAL EDITING CAN 
UNCOVER HIDDEN POTENTIAL 
IN EVEN YOUR BEST WORK

USING LEVELS INSTANT BLACK & WHITE EXCELLENCE
Simply add a Levels Adjustment and increase the Black Level to 10% 
and decrease the White Level to 90% for an instant contrast pop.

EDIT IN YOUR LUNCH BREAK WITH THE AMAZING AFFINITY IPAD APP
We’ve previously explored the massive power of Affinity’s iPad app, and once again you  
can use it to follow along with this entire tutorial. The best part is that you can take it 
anywhere, so grab a sandwich and sit down to create your mono masterpieces. 

STANDARD CONTRAST

ENHANCED CONTRAST

Affinity Photo 
Creative city scenes

PART 3
EXPLORING   

MONO URBAN 
ENVIRONMENTS

SOFT PROOFING
Designed to represent 
different print spaces, 

Soft Proof can also be used to 
add an artistic effect. Cycling 
between options can give you a 
subtle washed-out look, which is 
ideal for adding a sense of filmic 
depth to your black & whites.
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Add a subtle  
hint of HDR 
Open the new Layer 

in Tone Mapping Persona. 
Select Maximum Grit from the 
Extreme presets tab. Set Tone 
Compression to 25%, Local 
Contrast to 15% and increase 
your Blackpoint. Click Apply and 
adjust Opacity to suit your shot.

1
Create a black & white Gradient Map
Open the Adjustment Panel and choose Gradient Map. 
Click the left-hand circle, which will be red, click colour 

and select black. Do the same for the right circle, changing blue 
to white, and then the middle circle, choosing a mid-grey tone.

3
Increase your global Clarity
Click your Background Layer and Duplicate it with 
Ctrl+J. Open the Live Filters menu – the hourglass icon 

below your Layers Panel – and select Clarity Filter. Add a radius  
of 5-10px for local contrast to bring out your subject’s character.

4
Add a touch of noise for that film look
Again in the Live Filters menu, click Add Noise Filter. 
Make sure you’re set to Gaussian and not Uniform, and 

also have Monochromatic ticked. Set intensity to 15% to add 
grain. Right click and select Merge Visible to create a Pixel Layer.

Learn how to add a gritty 
feel to your street photos
A S FAR AS GENRES 

go, there are few as 
classic and inspirational as 
street photography, harking 
back to the days of pioneers 
such as legendary Magnum 
co-founder Henri Cartier-
Bresson and Vivian Maier, 
who tragically only achieved 

recognition posthumously. 
Whatever your inspiration, 

the subtle art of capturing 
candid moments has moved 
on relatively little since the 
days of film, and nowhere is 
this more obvious than the 
wide-spread use of black & 
white in modern street shots.

Of course, packing in a 
massive amount of flexibility,  
Affinity gives you more than 
one way to create stunning 
black & whites, and the 
powerful Filters, such as 
Noise, will allow you to add 
a hint of vintage grain to 
your work, really adding to 

that gritty look. The great 
thing about Affinity is that 
we can do this entire process 
non-destructively. Simply 
put, this means your original 
image remains 100% intact, 
allowing you to alter any of 
your changes at any point 
throughout your edit.

AFTER

BEFORE

Above & left Adding a black & white 
conversion, as well as increasing noise 
and clarity, has given us a completely 
different feel to our starting image, really 
helping to bring this character to life.

TIP 
EXPERIMENT 

WITH GRADIENTS
The Gradient Map allows 

you to add multiple points. 
Experiment with different 

tones for great 
results. 

KNOWHOW THREE WAYS 
TO GO BLACK & WHITE 
Black & white is a harsh mistress. Going mono is never as 
simple as desaturating an image, which is where Affinity’s 
range of powerful tools come in super handy. 

GRADIENT 
MAP 
You set 

custom colour 
values to shadows, 
midtones and 
highlights, such as 
black, grey and 
white, to create your 
mono. However, you 
can add additional shades and alter their placement to 
affect the image in real-time, which is perfect for bringing 
your precise vision to life. 

2
Adjust contrast
Double-click halfway between 
the left and middle circles to 

add a new point and choose a very dark 
grey. You can slide this to change your 
shadow strength. Repeat on the right-hand 
side, choosing a very light grey.

URBAN MONO  AFFINITY PHOTO 

HSL
Simply setting your Saturation slider to -100%  
is a very quick way to create a flat black & white 

image. However, changing Master to Red, Yellow or one  
of the other colours and increasing your saturation to 
+100% can give you some interesting, yet easy to create, 
selective colouring.

BLACK 
& WHITE 
By 

simply clicking on 
this Adjustment, 
Black & White 
instantly gives 
you a flat 
monochromatic 
image. However, 
using the 
assigned colour 
sliders allows 
you the freedom 
to alter the 
underlying 
colours, which is perfect for selective editing, especially 
when you have a busy scene.
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KNOWHOW 
WHY AFFINITY  
IS PERFECT  
FOR ASTRO
Offering the ultimate freedom 
allows you to craft your star shots 
from the ground up, perfect for 
revealing hidden details.

CLARITY 
This handy filter 
increases the local 

contrast, which can often be 
incredibly overpowering. However, 
in small doses, you’ll find your 
stars really pop against the 
blackness of the sky.

BLENDING MODES
One of the most 
underutilised features 

of image editing, Blending Modes 
allow you to alter the behaviour of 
a Layer in relation to the Layers 
below, which makes adding colour 
pops amazingly simple.

DEVELOP PERSONA
With so much of the 
information hiding in 

plain sight, the ability to convert a 
RAW file is essential. The Develop 
Persona’s powerful tools will allow 
you to increase the brightness 
of the stars, while retaining the 
darkness of your sky.

ASTRO  AFFINITY PHOTO 

Kirk Schwarz delves into the vast mystery of space 
with these two techniques to help you get the most 
out of your amazing astro and star trail shots.

S TARS – POSSIBLY 
the greatest 

inspiration the human race 
has ever known. Whether 
you gaze up in amazement 
on a dark, clear night, or you 
purposely study the outer 
reaches of our galaxy with a 
powerful telescope, chances 
are you’re blown away by 
what you see. Of course, the 
beauty of astrophotography 
is that what you see is only 
an infinitely small portion of 
what’s to be found, and your 
camera can help to uncover 

these mysteries. Shooting 
long exposures allows far 
more light to hit the sensor 
than the human eye can 
perceive, revealing a myriad 
of amazing details.

With a little bit of luck, 
a tripod and some jiggery 
pokery with your settings, 
you can easily wind up with 
a stunning dark sky-scape. 
However, taking the photo 
is only the first step in the 
process, and the real magic 
happens in post-processing, 
where you can bring out all 

of the unseen information, 
as well as correcting the 
colour and adding those 
finishing touches. 

What the pros use
The image above was shot 
and edited by leading 
astrophotographer – and 
keen Affinity user – Zdenek 
Bardon. The talented Czech 
photographer has edited 
countless shots in Affinity, 
and has even had some of the 
resulting shots published 
by NASA, which must 
surely count as one of the 
highest commendations 
either Affinity or Zdenek 
could receive. 

With such a wide range 
of industry-leading tools, as 

well as a can-do attitude 
and creative freedom, 
Affinity revels in creating 
the impossible. It even 
features an amazing 
Exposure Merging function, 
which, as you’ll see, allows 
you to create star trails, such 
as Zdenek’s, in a single click. 
This is something that was 
previously a laborious task, 
having to change Blending 
Modes on multiple Layers 
one at a time.

Don’t just take our word 
for it – get out there and 
shoot your own astro images, 
and once you’ve captured 
a RAW masterpiece, come 
back and follow our step-by-
step tutorial to really make 
them shine. 

THE REAL MAGIC HAPPENS  
IN POST-PROCESSING, WHERE 
YOU ADD FINISHING TOUCHES

BLENDING MODES SCREEN VS SOFT LIGHT
Screen hides the darkness in the Layer, where as Soft Light lightens 
anything over 50% grey, and darkens anything that’s darker.

CREATE YOUR OWN EPIC ASTRO SHOTS WITH THE AMAZING AFFINITY IPAD APP
Affinity Photo’s award-winning software is also available as an iPad app, and is perfect 
for editing on the move. If you want to work on your astro images while still under the night 
sky, the app is a perfect companion to check you’ve nailed the shot.

BEFORE

AFTER
Affinity Photo 
Explore the night sky

PART 4
THE ART OF  

SHOOTING STARS

Exposure Merging
Exposure Merging can 
be used on Image 

Stacks to take an average 
metering of the individual Layers 
and create the perfect exposure. 
This is ideal for star trails, but also 
very handy for anyone shooting 
bracketed landscape shots.
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5
Mask off the  
unwanted areas
Click the Brush Tool and 

set the colour to black. Now brush 
any area where you don’t want the curves to be visible, and the 
Layer Mask will hide them. To bring any area back, simply repeat, 
but change your foreground colour to white. 

1
Import as a New Stack
To open all of your star shots as a single multi-Layered 
document, go to File>New Stack. Click Add on the 

dialogue box and select your shots. Click Open, then Click OK 
to add them to your Layers panel – this will take a minute.

3
Merge your Layers to add finishing touches
Once you’ve created your amazing star trails, click on 
the Live Stack Group, the top Layer, and make sure it’s 

active. Right click and select Merge Visible. This will create a new 
Pixel Layer above the group, which you can edit further.

4
Perfect your contrast with Curves
Create a Curves Adjustment Layer. Now lower the left 
side of the Tone Curve to darken the shadows, and raise 

the right side to boost the highlights. Don’t worry if details get 
blown out, we will fix that in the next step.

Use Blending Modes to 
create amazing star trails
S TAR TRAILS ARE 

one of the most 
creative avenues of 
astrophotography, blurring 
the lines between fact and 
fiction to create a shot with 
a massive amount of visual 
impact. The great news 
is that they are actually 

incredibly simple to shoot, 
and even easier to create in 
Affinity Photo. 

To craft your shots, 
you’ll need to set your 
shutter speed to at least 
30 seconds, and take a series 
of continuous shots over the 
course of 20 to 30 minutes. 

The individual shots will 
have a slight trail to them, 
but with a little Affinity 
magic, you can blend them 
all together seamlessly to 
create one mega star trail. 

You’ll learn how to use 
Layer Stacks, bringing 
multiple photos into a single 

document as a series of 
Layers. You’ll also be 
exploring the Exposure 
Merging function, which 
allows you to get the best 
exposure from multiple 
shots with a single click. 
It’s so simple, you’ll have 
a masterpiece in minutes.

AFTER

BEFORE

Above & left In just two steps, you can import all of 
your individual shots and merge them together to  
create the final star trail image. 

TIP 
EXPOSURE 
MERGING

While Maximum works well 
for us, you can also try 
Range or Mid Range, 

which may work 
better.

KNOWHOW THREE WAYS 
TO USE BLENDING MODES 
Blending modes change the way individual Layers interact 
with each other. This can create some unique results, and 
these three are must-haves in your editing arsenal.

SOFT LIGHT
The Soft Light 
Blending Mode  

changes the values of the 
current Layer based on 
its relation to 50% grey. 
Anything which is lighter 
becomes brighter, and 
anything which is less bright 
becomes darker. It’s great 
for adding subtle contrast 
to your image.

2
Use Exposure Merge
Now you’ll have a Group 
called Live Stack. To merge 

your star trails, simply click the 
Exposure Merge icon to the right of the 
stack Layer and change to Maximum. 
This will instantly create epic star trails. 

ASTRO  AFFINITY PHOTO 
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EXCLUSION
Add a new Layer and use the Paint Bucket tool 
to fill the Layer with a navy blue. Now set the 

Blending Mode to Exclusion and you’ll notice the shadows 
are blue, and the highlights are yellow. Reduce the Opacity 
to 5% for a quick and easy cross-processing effect.

SCREEN
 Screen is an essential Blending Mode, and one 
you simply must know for creating composites. 

It makes blacks turn invisible, which is incredibly useful 
if you have an image with a subject you want to use, and 
a black background, such as fireworks or stars.



KNOWHOW 
WHY AFFINITY  
IS PERFECT  
FOR PORTRAITS
Affinity Photo includes industry 
leading tools, but manages to 
improve on them, especially in the 
case of blemish removal and skin 
retouching – a must for portraits. 
 

FREQUENCY 
SEPARATION
The ability to create a 

complicated frequency separation 
with a single click is amazing, 
allowing you to master this very 
powerful skin retouching 
technique from day one.

HEAL ALL ILLS
Affinity features a full 
complement of skin 

retouching tools, including a 
Healing Brush and Blemish 
Removal Tool. Using these, you 
can quickly and easily tidy up 
any little imperfections.

AFFINITY KNOWS
If you’re new to editing, 
Affinity Photo offers 

automatic tools. The Filters menu 
houses Auto Colours, Contrast 
and Levels, all of which are ideal 
to give you an instant boost and 
lead you in the right direction. 

COLOUR THE WAY  
YOU WANT IT
Colour is one of the most 

important tools you have at your 
disposal, and Affinity Photo has 
a great selection. Whether Colour 
Balance, Selective Colour or even 
the powerful Channel Mixer, you 
have all the tools you’ll ever need.

PORTRAITS  AFFINITY PHOTO 

Kirk Schwarz shows you how to use Affinity Photo 
to get professional looking skin, as well as adding 
an autumnal twist with a very simple colour edit.

T HE CONSTANT 
throughout all the 

seasons is stunning light, and 
we can take full advantage of 
this when shooting portraits 
whatever the time of year. 
We’ve themed our shoot with 
autumn in mind, but there’s 
inspiration to be found in 
every season.

While the later autumn 
months may be dominated by 
a magical show of changing 
colours and falling foliage, 
the earlier months change 
very little. We’ll show you 

how to use this to your full 
advantage by shooting in 
that fragile in-between time, 
when the leaves are firmly 
attached and the rich hues 
haven’t quite started to make 
their appearance yet. 

To achieve this warm and 
welcoming look, we’re going 
to use some of Affinity 
Photo’s powerful colour tools. 
This will allow us to subtly 
change the colour palette to 
suit our scene. We’ll also 
show you how to use the 
brilliant one-click frequency 

separation filter. This makes 
professional skin retouching 
an absolute doddle, allowing 
you to create outstanding 
results, which would be a lot 
more difficult to achieve in 
many other editing packages.

What will you need?
All you need to create your 
own autumnal wonderland is 
a nice portrait taken in an area 
with plenty of lush foliage. 
Don’t delay, as the seasons 
tend to disappear before our 
very eyes. When composing, 
you’ll want your subject to be 
perfectly in focus, as well as 
pretty large in the frame. 
This ensures the frequency 
separation will have the 
maximum impact when 

you’re separating the texture 
from the colours, which gives 
it that polished look.

To get the most out of this 
effect, you’ll want to use a 
shot with plenty of clean and 
contrasting colours, since 
you’ll be targeting specific 
hues to create your own 
colour scheme. If you have a 
model in a forest, make sure 
their face isn’t picking up the 
green hue which is often 
reflected from the trees or 
grass. Once you’ve selected 
your perfect shot, simply 
follow the next steps and 
you’ll not only master the art 
of powerful and advanced 
skin retouching, but you’ll 
also be an ace when it comes 
to colour grading.

THIS MONTH WE’RE USING 
THE TONE MAPPING PERSONA 
FOR STUNNING RESULTS

PORTRAITS NOT SURE? ASK AFFINITY TO HAVE A GO
Go to Filter>Colours>Auto Levels and watch in amazement as Affinity 
decides what level of contrast and toning best suits your image. 

FOLLOW ALONG WHEREVER YOU ARE WITH THE POWERFUL AFFINITY IPAD APP
The Affinity Photo iPad app is great for the busy portrait photographer. Thanks to its 
fully-featured approach, offering an identical level of functionality as the desktop app, 
you can even follow along to this whole tutorial.

BEFORE

AFTER

Affinity Photo 

PART 5
MASTERING  

PERFECT  
PORTRAITS

Create powerful portraits

Above Colour Balance allows you 
to create dramatic colour grading.
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2
Remove the blemishes and imperfections 
Click the High Frequency in the Layers Panel. Now 
choose the Blemish Removal Tool and click on a 

blemish. While holding down your mouse button, move the cursor 
to an area of clean skin and let go. Repeat until you’re happy. 

4
Use Gaussian Blur to smooth the skin
Choose the Free Hand Selection Tool and set Feather  
to 40px. Draw around any area where the texture needs 

smoothing. Go to Filters>Blur>Gaussian Blur and set a Radius 
that smooths the skin, but be subtle – 7.2px worked here.

1
Create a Frequency Separation 
Go to Filters>Frequency Separation. Slide the Radius 
until the texture on the colour half of the image has just 

become too blurred to make out. Click Apply and it will create two 
Layers. High Frequency is your texture, and Low is your colour.

3
Use the Clone Stamp Tool to even tones
Click on the Low Frequency Layer and choose the Clone 
Stamp Tool. Set Opacity to 20% and while holding Alt, 

click a source point. Now brush in over any area where the skin 
tone looks unnatural. This is great for bringing back highlights.

Create easy frequency 
separation in just one click
H AVE YOU EVER 

picked up one of 
those ultra-glossy magazines 
and seen models whose 
perfectly flawless skin looks 
too good to be true? Then it 
probably is! Even top models 
don’t turn up to the studio 
looking that great. It’s a 
combination of make-up 
artistry and some savvy 
post-processing. While we 
can’t recommend make-up 
artists enough, they’re 
probably overkill if all you’re 
doing is taking some nice 
shots of your friend. This just 
leaves the retouching option. 

Frequency separation is 
one of the most popular, and 
successful techniques in any 

pro photographer’s editing 
arsenal. It splits your image 
into two entirely different 
Layers. The first is a blurred 
Layer, which controls your 
colour, and the second is a 
texture Layer, which is set  
to a Linear Light Blending 
Mode. This allows you to 
work on your skin tones and 
skin texture individually. 

That may sound overly 
complicated, but Affinity 
Photo’s Frequency Separation 
is automated. That’s right, 
with a single click, Affinity 
creates your split Layers 
as required, while also 
allowing you to fine-tune 
each individual aspect for the 
best possible looking results. 

PORTRAITS  AFFINITY PHOTO 

AFTER

IMAGE AS SHOT

DETAIL BEFORE DETAIL AFTER

FREQUENCY SEPARATION

AFFINITY PHOTO MAKES 
COMPLEX RETOUCHING 
INCREDIBLY SIMPLE

Above The heat and direct light makes the skin look a little blown 
out. In four steps, the skin looks smooth and natural.

HEALING BRUSH TOOL
This allows you to set your own source point, like 
the Clone Stamp, but automatically blends in 

based on the surroundings – ideal for texture work.  

BLEMISH BRUSH TOOL
This tool allows you to click on any area, and drag 
to a new area where you prefer the texture. It then 

blends it in seamlessly by calculating the texture and 
colour in the area around your selection.

INPAINTING TOOL
This brilliant tool lets you paint over an area, and 
Affinity will work out what to fill it with, based on 

the surrounding areas. This makes it ideal for removing 
unwanted distractions from your scenes.

KNOWHOW THREE STEPS TO INNER HEALING

TIP 
BRUSH IT IN

If there isn’t enough clear 
skin to clone from, select 
the Brush Tool and set the 
Opacity to 15%. Holding 

Alt lets you pick a 
close colour.
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KNOWHOW THREE GREAT 
WAYS TO CREATE COLOUR
Adjustment Layers are the backbone of any good editing 
software, and Affinity Photo has them in spades. These 
are three amazing ways to alter your images’ colour.

HSL
HSL stands for 
Hue, Saturation 

and Luminance. It allows 
you to choose specific 
colour channels, and alter 
the value of each hue, 
meaning you can change  
all of your original colours. 
You can also control the 
saturation and brightness. 

SPLIT TONING
Split Toning 
assigns different 

colour values to the 
highlights and shadows. 
You can then choose a bias 
to decide which colour 
dominates. This simple 
technique can create a wild 
effect, or just introduce 
complementary colours into 
your work, which really 
draws in the viewer’s eye.

2
Use HSL to alter the leaves
Create an HSL Adjustment and change Master to Yellow.  
Drag the Hue slider right to 0.8, depending on your 

scene, to change the yellow to autumnal browns. Change Yellow 
to Green and repeat this to even out the tones.

5
Apply an autumnal Gradient Map
Create a Gradient Map Adjustment and choose the 
green default. Click the middle circle and delete it. Now 

click the right most circle and change the colour to green. Set the 
Blending mode to Screen and Opacity to 10% and you’re done.

1
Warm the colour balance
Open the Adjustments tab and choose White Balance. 
Sliding right towards orange will warm your image, 

whereas sliding left will make it more blue, or cool. You want to 
slide right, until your shot looks as though it was taken at sunset.

3
Use Layer Masks to erase the colours
Altering the Hue may have changed other areas of your 
shot. To undo this, click on the HSL Layer and use a Soft 

Edged Paint Brush Tool to brush black over any areas you don’t 
want this to be visible, such as the skin or grass.

4
Add a global Colour Balance
Create a Colour Balance Adjustment and drag the Cyan/
Red slider right to introduce a warmer, more autumnal 

light. Now drag the Magenta/Green and the Yellow/Blue sliders 
left. You should have a warm tint but with natural skin tones.

Use colour to change 
summer into autumn
C OLOURS ARE AN 

intrinsic part of our 
daily lives, and they dominate 
our world. In photography, 
they are one of the most 
important tools you have to 
connect with your viewers. 
However, cameras don’t 
always capture the vista as 

we see it. RAW files retain 
basic data about the scene, 
but it’s up to you to bring that 
information out as you want 
to show it. Similarly, JPEGS, 
which don’t capture the 
same level of detail, look a lot 
more vibrant out of camera. 
However, a JPEG is an image 

file which has been edited by 
your camera, so it’s still not 
guaranteed to show the 
viewer that epic scene you 
want to convey. 

Take control of colour
We’ve already learned how 
powerful Affinity can be, but 

it’s the small things that can 
make the biggest difference. 
Everyday tools, such as 
Colour Balance and Selective 
Colour, can be used to make 
subtle tweaks, or even to 
completely change the look 
and mood of your scene, as 
we’ll find out now.

PORTRAITS  AFFINITY PHOTO 

AFTERBEFORE

TIP 
FEELING 

BLUE
If you want to make this feel 

more wintry, shift your 
Colour Balance to blue 

instead of warmer 
tones.

COLOUR BALANCE
Colour Balance is a much-used tool. It’s 
responsible for values of colour in a particular 

image, and can be used to subtly grade you work, or even 
create a dramatic mood by cooling down the scene, or 
using it to mimic soft warm summer light.



KNOWHOW 
WHY AFFINITY IS 
PERFECT FOR 
COMPOSITES
Affinity Photo boasts powerful 
features, such as selection tools, 
Layers and Masks, all of which are 
essential for digital mash-ups. 
 

MAKE YOUR  
SELECTION
Affinity offers a handful 

of tools which allow you to create 
selections, ranging from quick 
and easy, to extremely precise 
and complex. This is a key area 
when it comes to creating 
intricate composites. 

THE MIGHTY PEN
The Pen Tool allows 
for the most precise 

selections, letting you fine-tune 
the direction of travel, as well as 
create pixel-perfect curves and 
spot-on cut-outs.

LAYER MASKS
Layer Masks allow you to 
hide an individual Layer’s 

effects from the rest of the image, 
while retaining the information 
should you change your mind at 
a later date – an essential for 
complex composites.

LEARN TO REFINE
Refine allows you to alter 
your selections after 

the fact, going as far as offering 
a Matte Brush, which makes 
Affinity do the hard work on tough 
selections, such as flyaway hair. 
This makes the whole selection 
process incredibly powerful and 
very professional.

 AFFINITY PHOTO 

Kirk Schwarz takes you on a journey to create 
the next protector of the human species in this 
impressive superhero composite tutorial. 

L OOK, IN THE SKY. 
Is it a bird? Is it a 

plane? No, it’s a billboard 
for the latest Hollywood 
superhero flick. Watching 
fully-grown men being flung 
through skyscrapers, or  
going toe-to-toe against 
gigantic aliens is just good 
fun, and the inspiration 

behind our final Affinity 
Photo instalment. 

Throughout the guide so 
far, you’ve learned how to 
edit landscapes with the 
Develop and Tone Mapping 
Personas, you’ve gone 
through complex colour 
grading using some of the 
best tools on the market, and 

you’ve mastered the art of 
black & white conversions. 
One thing we’ve yet to cover, 
which Affinity Photo does 
incredibly well, is the art of 
creating selections. Powerful 
features such as the Pen, 
Selection Brush and Flood 
Select Tools are perfect for 
making complex cut-outs – 
essential for creating our 
composite superhero image.

Where do I start?
The most important shot 
you’ll need is the hero, which 

in this case, is a hero. We’ve 
posed him in a dynamic way 
and we can still cut him out 
precisely. You’ll also need a 
gritty background, such as 
this city shot we’re using. 
Lastly, we’ve added some 
fiery wings for that extra 
final wow factor. 

With all of your individual 
components shot or sourced, 
it’s just a case of jumping 
into Affinity to cut them out 
and put them all together to 
create your epic cinematic 
masterpiece.

AFFINITY’S SET OF NIFTY 
SELECTION TOOLS IS IDEAL TO 
CREATE EPIC COMPOSITES

SELECTING IMAGES ALWAYS  
THINK OF THE BIGGER PICTURE
Find your background first, then create 
the scene around this. We had a gritty 
background, which would allow us to 
compose our flying effect. We shot the 
model in a dynamic hovering pose and 
thought the addition of flames as wings 
would help to sell the whole effect. 

BACKGROUND MODEL

FLAMES

AFTER

Affinity Photo 
Composite creatively

PART 6
SUPERHERO  
SHOWDOWN
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2
Cut out your superhero
You now need to remove your hero from the background. 
If the background is pure white, you can use the Flood 

Select or Selection Brush Tools. However, if you have a busy 
background like ours, select the Pen Tool for precision. 

6
Turn your outline into a selection
Once finished, head to the toolbar at the top and press 
Selection to create a path of marching ants. Now hit 

Ctrl+J to duplicate this Layer and delete the original. Use the 
Move Tool to resize and place your model.

8
Place the shadow and add some blur
Move the shadow to the street below and grab the top  
of the movement box. Drag this down to squash the 

shadow Layer. Click Live Filters and choose Gaussian Blur. Move 
the slider right until the shadow’s edges are more natural. 

4
Create natural curved selections
Click once more but don’t let go. Drag the mouse in any 
direction. You’ll see a line come out of the central anchor 

point, which will create a curve in the Pen Tool’s line. Drag until 
this fits the outline of your model but don’t let go.

1
Open your background shot
To give yourself bearings, open the background shot 
first, by clicking File>Open. Once imported, you have 

a reference point to work with. Next, select your superhero model 
shot and import it by going to File>Place.

5
Tell the Pen Tool where to go next
Still holding down your mouse button, hold down the 
Alt key and drag the mouse to move the line that was 

responsible for the curve. Point it in the direction of your next 
point and the transition will be much more natural.

7
Create a realistic shadow
Duplicate your model Layer and open a Levels 
Adjustment. Set Black Level to 100%, right-click the 

Layer and select Mask to Below. Now right-click on the model 
and choose Transform>Flip Vertical.

3
Trace the outline with the Pen Tool
Zoom in and click on the edge of your model, where you 
intend to start the selection. Now click a little further up. 

You should see a straight line appear, which isn’t good for cutting 
out rounded shapes, so we need to learn how to create a curve...

Make your selections wisely
T HE KEY TO ANY 

photo composite 
is being able to have your 
individual elements interact 
seamlessly. This means being 
able to have hard edges, or 
even soft edges, appear as 
they should. It’s also essential 
that you don’t include the 
background when you’re 
cutting out a model, or 
accidentally cut off parts of 
them. Thankfully, Affinity 
has three great tools for this. 

You’ll be able to take 
advantage of the Selection 

Brush or Flood Select Tools, 
both of which offer a simple 
one-click approach, and 
both of which do an excellent 
job. You also have the Pen 
Tool, which allows you the 
ultimate freedom and control. 
Simply clicking from one 
point to another will create a 
line. You can then add natural 
curves to these lines, as well 
as move them or change the 
effect at any point, all of 
which make those precise 
selections very easy to master 
– ideal for our superhero shot. 

COMPOSITES  AFFINITY PHOTO 
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Above The powerful selection tools in Affinity make cutting out 
your characters simple, while also giving you ultimate control. 

SELECTION BRUSH TOOL
This tool allows you to paint 
your selection in, making it 

ideal for large areas with high contrast 
or strong geometric shapes.

THE PEN TOOL
The most powerful and 
precise tool, this allows you 

unlimited freedom to make curved and 
pixel-perfect selections.

FLOOD SELECT TOOL
With a single click, you can 
select an entire tone or 

colour. You can even change the 
Tolerance, giving you a lot of control.

KNOWHOW LEARN TO USE THE BEST TOOL FOR THE JOB
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HOW TO GET 
AFFINITY PHOTO 
ALL YOU NEED 
TO KNOW
Affinity Photo is yours 
for the one-off cost of 
£48.99, or only £19.99 
for the iPad app. It’s 
available on both 
Windows and Mac 
operating systems. To find 
out more about the desktop and iPad versions of Affinity 
Photo, visit affinity.serif.com/photo where you’ll also find a 
selection of video tutorials helping you get the best out of 
the editing software to make the most of your images.  

2
Add your fiery wings
Use the Eraser Tool ‘E’ to delete all but one fireball. Once 
you have your single flame, use the Move Tool to put it 

into place, and change the Blending Mode to Screen, which will 
hide any black in the image making it invisible. 

4
Mask out the front of the flames
Create a Layer mask for the new Group. Choose the 
Paint Brush Tool ‘B’ and set hardness to 50%. Select 

black as the foreground colour and brush where you don’t want 
the flames visible, which is the chest and arms. 

9
Add your final adjustments 
Click on your top Layer and create a Curves Adjustment. 
Add an ‘S’ curve, which looks like the example above, 

to add additional contrast. You can now also add any additional 
adjustments that you may have learned from previous tutorials. 

1
Import your ‘special effects’ shot
We have this shot of three fireballs, which we’re bringing 
into the document by clicking File>Place. Once in, 

duplicate the Layer and hide the original by de-clicking the tick 
to the right of its Layer. We will need this Layer later on. 

3
Make the effect even brighter
The Screen Blending Mode can cause transparency. To 
get around this, duplicate your Layer for a better effect. 

Once you’re happy, hold Ctrl and click every fire Layer to select 
them. Press Ctrl+G to put them all into a single group. 

Blend images to 
create a story
A FLOATING MAN 

may be pretty 
impressive in real life, but it 
takes quite a bit more than 
basic levitation to pass for a 
superhero these days. With 
this in mind, we’re going to 
add some fiery wings to make 
our model really look the 
part. Although it may sound 
extremely difficult to achieve, 
it’s a very simple effect, and 

can be accomplished with a 
stock photo and the Screen 
Blending mode. While you 
may not have a lot of images 
of fireballs at your disposal, 
you can easily shoot fireworks 
or sparklers against a dark 
sky to get the same effect, 
then you can use this simple 
technique to give your hero 
some fiery abilities of their 
very own. 

Above The ability to use multiple Layers and Masks is a must  
for anybody who is creating composite images. 

6
Paint in the flames’ reflection
Flames will create a colour cast, so we need to add that. 
Create a new Pixel Layer and use the Paint Brush Tool. 

Set Flow to 10% and the Foreground Colour to Orange. Paint 
where the light should fall and set the Blending Mode to Soft Light.

8
Mask off the Motion Blur effect 
Click on the Motion Blur Layer, which includes its own 
Layer Mask. Now use a black Paint Brush Tool to brush 

out the blur effect over the model’s face and torso. You can 
always paint it back in by switching from black to white.

5
Repeat for the  
other wing
Take the flame Layer we 

hid earlier and make it visible. Now 
repeat the process, but when you’re using the Move Tool to place 
it, right-click and choose Transform>Flip Horizontal. Now put it in 
place and mask it out, as per the previous step. 

7
Add some movement to your model
Click back to your model Layer and create a Live Filter 
Motion Blur. Set the rotation to 90% (or to suit your 

pose) and Radius to 30px, which should create a sense of motion. 
Unfortunately, it’s blurred the whole model Layer...

TIP 
TAKE STOCK

Stock sites can get 
expensive, but there are 

100% free alternatives such 
as unsplash.com where 

you can find 
useful images.


